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ECE 412 MP1 
Introduction to Field Programmable Gate Arrays 
This laboratory assignment serves as an introduction to the Xilinx Field Programmable Gate 
Array (FPGA) design systems.  You will become familiar with XUP board that will be used as 
the platform for all future ECE 412 machine problems.  You will use Precision Synthesis to 
compile and optimize a hardware description written in VHDL and the Xilinx ISE to map, place, 
route, and download to the FPGA. 
 
 
1.0  Introduction 
This machine problem is designed to be a basic introduction to FPGA design.  An FPGA is 
essentially a large array of logical function generators with a programmable interconnection 
matrix.  There currently exists an assortment of ways to program these arrays.  One option is to 
manually set each connection, route, and function generator, but this method requires extensive 
knowledge of the chip and is only typically used for refining designs produced by one of the 
more automatic methods.  The two main automated approaches for configuring programmable 
logic are schematic capture and hardware description languages (HDLs) such as Verilog or 
VHDL.  In schematic capture, a designer will use a graphical interface to draw a schematic using 
simple gates as well as more advanced structures that are available in libraries.  Since schematic 
capture is visually oriented, it is fairly easy to picture the design as it is implemented in the 
FPGA.  On the other hand, a HDL is a text-based method for design entry that resembles 
software programming more than hardware design.  Designing with HDL introduces a 
significant level of abstraction, which eliminates the clear mapping to hardware that exists in 
schematic capture.  This abstraction however allows the development of very large, complex 
designs involving thousands to millions of gates in much less time than that required for 
schematic capture.  In this course, we will be using VHDL (VHSIC Hardware Description 
Language) exclusively as our hardware design tool. 
 
This MP is divided into four checkpoints.  The first checkpoint is primarily a tutorial intended to 
introduce you to the tools for VHDL compilation, simulation and synthesis that you will be using 
throughout the semester.  When this part is complete, you will have implemented an 8-bit 
counter on the XUP board with status displays in both binary and hex.  This course uses 
Precision Synthesis for VHDL compilation, Mentor Graphics’ ModelSim for simulation, and 
Xilinx for synthesis to the Virtex2 Pro FPGA. This course also uses Xilinx EDK package for 
building designs using the PowerPC 405 processing cores on the Virtex2 Pro FPGA. By the 
second checkpoint, you should have designed a reader for a PS/2 keyboard that implements the 
device-to-host portion of the PS/2 protocol and displays the make and break codes in hex on the 
XUP board.  The third checkpoint is left open-ended so you can challenge yourself to be as 
creative as possible. The fourth checkpoint requires you to bring up Linux on the XUP board and 
interface to it using HyperTerm.  
 
By the time you finish this machine problem, you should be comfortable with basic VHDL 
syntax, state machine design, and all of the design tools mentioned above. 
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2.0  Checkpoint Requirements 

2.1 Checkpoint 1 
·  Due: 1/29 
·  Credit:  15 points 
·  Tasks: 

1. Logic Analyzer Tutorial 
2. Connect logic analyzer to counter and obtain a screen capture 

·  Demonstration: Demonstrate a counter with working hex display to one of the TAs. 
·  Documentation: One ModelSim simulation trace of this design. In addition, you must 

produce a logic analyzer screenshot matching that provided in this handout. For all 
checkpoints, you should place items requested in this section in your report, which is due 
shortly after completion of the entire MP. 

2.2 Checkpoint 2 
·  Due: 2/3 
·  Credit: 30 points 
·  Task: Design a PS/2 keyboard reader that displays the last make or break code received 

in hex on the 7-segment displays, and shows the parity bit on the bar LEDs. Note that this 
CP only requires you to implement device-to-host communication. Host-to-device 
communication information is included in this packet strictly for reference, but makes an 
excellent quiz question… 

·  Demonstration: Demonstrate a working keyboard reader to one of the TAs. 
·  Documentation: A minimum of 1 new simulation trace is required for this checkpoint. 

Along with the trace, provide the do file you used. Discuss your implementation of the 
keyboard reader. 

2.3 Checkpoint 3 
·  Due: 2/10 
·  Credit: 30 points 
·  Task: Use the resources on the XUP board (LEDs, switches, pushbuttons, PS/2 interface, 

etc) or DIO2 board to create your own design.  Be creative and challenge yourself. 
·  Demonstration: Present your design to one of the TAs.  Discuss any interesting or 

unique features with them.  If schematics or simulation traces will help us understand 
how the circuit works, bring them along. 

·  Documentation: A minimum of 1 new simulation trace is required for this checkpoint. 
Along with the trace, provide the do file you used.  Be sure to discuss your design 
thoroughly. 

2.4 Checkpoint 4 
·  Due: 2/10 
·  Credit: 5 points 
·  Task: Install the Compact Flash card into the XUP and boot the Linux kernel.  
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·  Demonstration: Present your design to one of the TAs. HyperTerm must show Linux 
booting up.  

·  Documentation: There are no schematics or simulation traces that you are responsible 
for in this checkpoint. In the report discuss any challenges you had bringing up Linux and 
how you resolved them. (If you had any) 

 

2.5 Report 
·  Due: 2/12 
·  Credit: 20 points 
·  Task: Your discussion should explain the motivation behind your designs in the above 

checkpoints and present your results.  The points allocated in Checkpoint 3 for originality 
and creativity will be influenced by how well you convey your ideas to us in the report. 

2.6 Find a Partner for MPs 2 and 3 
·  Task: Find someone in the class you can work with.  This lab is a lot of work, and your 

partner is counting on you for his or her grades.  More importantly, they are counting on 
you to help them figure out the labs, wade through the data sheets, come up with ideas, 
etc.  We expect you to work together as teams.  If there is anything we can do to help you 
out with this, just let us know.  



Introduction to Field Programmable Gate Arrays 

4 of 26  ECE 412 – Spring 2007 

3.0  HDL Designer, Precision Synthesis, Xilinx Introduction 
 
This overview will serve as a review of HDL Designer and introduce you to the design tools you 
will be using throughout the semester to compile, place, and route your VHDL designs for an 
FPGA (Field Programmable Gate Array). The VHDL compiler we will be using is Precision 
Synthesis. The Xilinx ISE will take care of mapping the compiled design into an actual device. 
The design flow is illustrated in Figure 3-1. 
 

 
Figure 3-1: FPGA Design Flow 

Upon completion of this machine problem, you will have modified an 8-bit counter designed for 
the Virtex2 family of Xilinx chips.  For this course, we will be using the Xilinx Virtex2 Pro 
XC2VP30-7-FF896 FPGA. 
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3.1 Getting Started 
1. From your workstation account in the Everitt EWS Lab (eelnx<1-47>.ews.uiuc.edu), type 

ece412  in a terminal window. This script sets the proper path and environment variables as 
well as changing to your work directory. 

2. Download the HDLdesigner given files (mp1_cp1_given.tar.gz) from the course website 
and save them to your 412 work directory.  Then perform the following commands to 
uncompress the files: 
gunzip mp1_cp1_given.tar.gz 
tar –xvf mp1_cp1_given.tar 

3. Note the directory structure that is automatically setup to be used for MP1. The above 
process should create an ece412 subdirectory, with files unzipped into that directory. 

4. Type fpgadv at the prompt.  If you have used an older version of HDL Advantage in the past 
and this is your first time running the new version, you may be prompted to convert your old 
libraries to the new version.  It is up to you if you wish to try and convert your old libraries or 
not. 

5. Create a New Project  
5.1. File �  Close Project 
5.2. File �  New �  Project 
5.3. Fill in the name of the project and the directory where you unzipped the given files.  

 
Figure 3-2 Create a New Project Window 

5.4. Click Next twice until you get to the “Project Content” window.  Select “Open the 
Project” radio button and press Finish 

5.5. Click on the Project tab in the lower left corner of the window. 
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5.6. Double-click on the Downstream folder under the ece412_lib library. 
5.7. In the window that pops up, select “ModelSim 5.6 – 5.8 Compiler” in the dropdown box 

and enter “/work1/ece412/<netID>/ece412_lib/work” for the path. Click Ok.  Repeat this 
process for “Precision Synthesis Prepare Data” with the path 
“work1/ece412/<netID>/ece412_lib/ps”.  This sets the directories where the simulation 
and synthesis tools will store their temporary files.  Your Design Manager should now 
look like Figure 3-3. 

 

 
Figure 3-3 Design Manager with Downstream directories 

 

3.2 Functional Simulation 
1. Click on the ece412 tab in the lower left-hand corner (or double click on ece412_lib under 

Regular Libraries) to bring the library Design Explorer back. 
2. Select your top-level design file by clicking once on mp1_cp1 in the Design Units pane of 

the Design Explorer and click on the “M” button (make sure ‘generate and run entire 
ModelSim flow (through design root)’ is the button selected). A window similar to that in 
Figure 3-5 should appear. 

 
Figure 3-4 What the ModelSim button looks like 
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Figure 3-5 ModelSim Settings 

3. Make sure your settings match Figure 3-5 and then press OK.  Ensure that “Enable 
Communication with HDS” is enabled. 

4. There are several ways to operate ModelSim.  Commands can be entered manually at the 
VSIM prompt, but a more convenient approach is to list these commands in a “do” file and 
run this file in “batch” mode.  The following is a sample do file (in Listing 1) that sets up a 
simulation for the counter entered above.   

5. Type in the do file in Listing 1 and save it as count.do in your /ece412_lib/work directory.  
Type do count.do  at the VSIM prompt. The resulting waveform will appear as in Figure 
3-6.   
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Figure 3-6: Waveform display for the counter 

6. You can generate Postscript output from the wave window for inclusion in your reports by 
clicking File->Print Postscript… in the Wave window.  Make sure to click the File name 
radio button, and specify a filename for your Postscript output. You should also select an 
appropriate Time Range (Full Range is reasonable for this simulation).  The Write Postscript 
window will look like the Figure 3-7.   

7. You can close ModelSim now. 

Listing 1: Sample Do File  
 
# Clear previous forces and wave window 
restart -force -nowave 
# Insert signals in wave display window 
add wave -logic /mp1_cp1/slow_clk 
add wave -logic /PB_ENTER 
add wave -logic /mp1_cp1/count 
add wave -logic /mp1_cp1/divisor 
# approximately 32 MHz clock on signal CLK_32MHz 
# (0 at 0ns, 1 at 16ns, repeat at 32) 
force -deposit /CLK_32MHz 0 0, 1 16 -r 32 
# Initially reset the system, then set PB_ENTER ina ctive at time 32 
force -deposit /PB_ENTER 0 0, 1 32 
# Force slow_clk to be 8MHz so that simulation does  not take forever 
force -deposit /mp1_cp1/divisor 4 0 -r 1 
# Execute the simulation for 1000 ns 
run 1000 
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Figure 3-7: Write Postscript 
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3.3 Compiling a VHDL File for Synthesis and Generating a Bit File for the 
FPGA 

1. Select your top level design (mp1_cp1 in this case) and click on the Precision Synthesis 
button in the top toolbar (again make sure ‘(through design root)’ is the button selected).  

 
Figure 3-8 

2. Select the Xilinx VIRTEX-II Pro from the Technology box.  The Device is 2VP30ff896.  
Speed grade is -7.  Check the “Overwrite Implementation folder” box. Ensure that your 
settings match the window below, and then click Ok. 

 
Figure 2-9 

3. You can monitor the progress of Precision Synthesis by clicking on the Transcript button 
in the lower left-hand corner of the screen.  Synthesis has completed when the log reports 
“HDL Designer Synthesis run finished”. 
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4. Once synthesis has completed, click File/Save Active Implementation.  Precision 
Synthesis created an EDIF file called mp1_cp1.edf.  For this MP we will be downloading 
this intermediate netlist to the PCs in EL231 and generating the bit files from there; on 
future MPs we will use the EWS Place and Route tools and generate the bit file on the 
EWS machines. 

5. You may now close Precision Synthesis 
 
 

 

3.4 Getting the Design to EL231 
1. Go to the ECE 412 Lab (room EL 231).  Make sure the bench and computer are turned on. 
2. Click Start /All Programs/WinSCP3/WinSCP 
3. Enter eelnxYY.ews.uiuc.edu in the host name field , where YY is a number 

between 1 and 47.  
4. Enter your EWS login and password. Click Login. 
5. Double Click on the ece412.work folder 
6. Navigate to /ece412_lib/ps/mp1_cp1_struct/mp1_cp1_struct 
7. Download the file mp1_cp1.edf to a folder on the W: drive.   
 
You should then transfer your file to an appropriate directory on the network drive (W:) so that 
you won’t have to re-download your files via ftp all the time (or be forced to use the same lab 
station each time).  Also, only the network drive is backed up, so anything you store on the local 
hard drive may be lost in the event of a format. 
 
3.5 Creating the Bit File 
For this MP we will be learning to run the tools in command line mode.  In future MPs we will 
be using a batch file or the Xilinix ISE GUI. 
1. The scripts should access the network paths and be able to place and route in your W: 

directory. Try not to have any spaces in the names of the directories. If you do get weirdness 
then you may have to move the .edf to a temp directory on the C: drive.  

2. Open up a command prompt by clicking Start/Run and typing cmd 
3. Navigate to the folder you downloading the .edf file  
4. Copy mp1_cp1.ucf to this folder from the web (it comes zipped) 
5. First, we must convert the netlist to a proprietary NGD format for working within the Xilinx 

tools.  Type: 
ngdbuild -p virtex2p mp1_cp1 
(The ngdbuild command uses the –p parameter to specify the device.  mp1_cp1 is the name 
of the design) 

6. Second, we will map the logic equations to the logic blocks with map.  (map accepts the 
architecture size and speed as parameters) 
map -p xc2vp30-7-ff896 mp1_cp1.ngd 

7. Third, we will associate the logic blocks with physical logic locations on the chip and 
interconnect them with Place and Route. 
par -w mp1_cp1.ncd mp1_cp1.pcf 

8. Lastly, generate the bit file that will be loaded onto the FPGA. 
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bitgen mp1_cp1.pcf.ncd -l –w -g StartUpClk:JtagClk 
 

3.6  Downloading the Design 
The bit file created by the Xilinx XST is a list of connections to be made inside the FPGA. This 
section explains the procedure for downloading the bit file to the FPGA. 
1. Turn on the power supply to the XUP board. 
2. Make sure the USB cable is plugged in. 

**Next steps you only have to do once** 
3. Create a directory on your W: drive to hold an Impact start up file  
4. Go to Start�  All Programs� Xilinx ISE 8.2i�  Accessories� iMPACT 

(Or type impact from a command prompt) 
5. A project window will start up. Select “Create a new project (.ipf)”, leave the name the same.  
6. Check the “Load most recent project file when iMPACT starts” button and hit “OK”. 
7. In the Welcome window select the “Enter a Boundary-Scan chain manually” pull down item. 

Click Finish.  
8. Right click on the white space where it says “Right click to Add Device or Initialize JTAG 

chain”. Select “Initialize Chain”. 
9. iMPACT should detect three devices on the XUP board connected in series.  The FPGA is 

the third device in the list.  It will now prompt you for a file to load on each device.   
10. Cancel the next 3 “Assign New Configuration File” boxes.  
11. Go to File->Save Project As. Select the W: location you made for impact and save the 

default.ipf file.  
** From now on when you load impact it will start at this point, you will not need to redo the 
last 9 steps ** 

12. Right click on the xc2vp30 part and select “Assign New Configuration File”. Click the top 
“Add..” button and select the .bit file you generated. (See Figure below) 

13. Click Ok in the Add Object Files box.  The bit file is now assigned to the FPGA, but has not 
been loaded yet. 

14. Right click on the FPGA and click Program.  Make sure “Verify” is not checked. 
15. Your XUP board is now configured with the circuit in your .bit file and you should see the 

output of the counter displayed on the LEDs. 
16. When you exit iMPACT it will ask you to save the configuration file. Select “No”, unless 

you like to start up at a point that is after configuration of the FPGA next time.  
 
For future reference, in step 12 a copy of the bit file you specified is associated with FPGA.  This 
means if you change the bit file on your hard drive without closing iMPACT you will have to do 
the following: 
 

Reinitialize the chain (ctrl –i) 
Bypass the first two Add configuration file boxes 
In the third box navigate to your new file and hit open/ok 

 
For additional information on using the XUP board, please consult the XUP manual that is 
included in the course manual (it is also available on the website under Documentation).  When 
you are about to leave the lab, please be sure you have powered down your XUP board. 
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Figure 3-10 Downloading the Bit file 
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4.0  Design Verification Using the Logic Analyzer 
It is always a good idea to verify the functionality of your design using the logic analyzer—even 
if you think it’s working perfectly. Having attended the logic analyzer tutorial session after class, 
you should be able to connect the analyzer to the XUP board and verify that your counter is 
indeed counting. (See a TA or a friend if there was no such tutorial) If you have any questions 
about setting up the logic analyzer, please attend a TA’s office hours and ask them for help. The 
following is a list of tips and suggestions: 
 

·  You will need to modify the design to send the desired signals out to accessible pins.  In 
this MP, the port Debugout has been provided to you for this purpose.  Examine the 
mp1_cp1.ucf file for the pinouts and their associated expansion connector pins.  The 
XUP has four expansion connections, J1-J4, numbered left to right starting with pin 1 in 
the lower-left corner.  Refer to the XUP user guide for the location of these headers. 

·  Take a screenshot of the output and save this as a jpg file. 
·  Make sure you change the time scaling to something appropriate for your design. 
·  Don’t forget to set the trigger.  There are many “correct” ways to trigger in this particular 

design.  For example, you could trigger on the clock.  This would mean that the analyzer 
will begin collecting data at the first clock edge after you press run.  You could also 
trigger on the reset signal (PB_ENTER), or even on a specific value of the counter, but 
you only have a limited number of debug pins to work with.  Experiment on your own 
with this. The more familiarity you have with the analyzer, the better off you will be in 
future MPs. 

·  You can save configurations in the logic analyzer.  This includes all triggers and capture 
preferences you have specified for a debugging session. 

·  Your trace should include the ~1Hz clock (slow clock), BAR LED counter value 
(counter), and the two 7-segment display values (left and right hex).  Set up the trigger 
for counter value 0x08; the output will be centered around 0x08. 
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Example Outputs from the Logic Analyzer 

 

 
Figure 3: State - Synchronous Sampling using the clock pin on the pod 

 

 
Figure 4: Time - Asynchronous Sampling using 1ms sampling period 
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 PS/2 Keyboard Overview  

4.1 Introduction 
This document describes the interface used by the PS/2 keyboard covering the physical and 
electrical interface, as well as the protocol.  Section 5.2 describes the basic physical and 
electrical interface including the bits in a data packet transferred across the bus.  Section 5.3 
contains the specifics of device-to-host communication while section 5.4 describes host-to-
device communication.  Throughout this document, the XSV board and keyboard will be 
referred to as the host and the device respectively.  This description of the PS/2 protocol is 
largely based on the work of Adam Chapweske. 

4.2 General Description 
The physical keyboard port we will be working with is the 6-pin mini-DIN.  The pinouts are 
shown below:  
 

 
Male 

 
(Plug)  

 
   Female 

 
  (Socket)  

6-pin Mini-DIN (PS/2) –  
1 – Data 
2 – NC 
3 – Ground 
4 – +5V 
5 – Clock 
6 – NC 

 
The host supplies the +5V and the device and host share an electrical ground.  The Data and 
Clock pins are both open collector, which means they are normally held at a high logic level 
with large pull-up resistors but can easily be pulled down to ground.  Thus logic 0 is asserted by 
pulling the pin to ground while logic 1 is asserted by letting the line float high. 
 
The PS/2 keyboard bus is a bi-directional synchronous serial protocol.  In other words, Data is 
sent one bit at a time on the Data line and is read each time Clock is pulsed.  The device can 
send data to the host and the host can send data to the device, but the host always has priority 
over the bus and can inhibit communication from the device at any time by holding Clock low.  
 
Data sent from the device to the host is read on the falling edge of the clock signal (when Clock 
goes from high to low); data sent from the host to the device is read on the rising edge (when 
Clock goes from low to high).  Regardless of the direction of communication, the device always 
generates the clock signal.  If the host wants to send data, it must first tell the device to start 
generating a clock signal as will be described in a later section.  The maximum clock frequency 
is 33 kHz and most devices operate within 10-20 kHz. 
 
All data is arranged in bytes with each byte sent in a frame consisting of 11-12 bits.  These bits 
are:  

·  1 start bit (always 0) 
·  8 data bits (least significant bit (LSB) first) 
·  1 parity bit (odd) 
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·  1 stop bit (always 1) 
·  1 acknowledge bit (host-to-device communication only) 

The number of 1’s in the data bits plus the parity bit always adds up to an odd number (odd 
parity).  This is used for error detection.  
 
When the host is sending data to the device, a handshaking bit is sent from the device to 
acknowledge the packet was received.  This bit is not present when the device sends data to the 
host.  

4.3 Device-to-Host Communication 
The Data and Clock lines are both open collector (normally held at a high logic level.)  When 
the device wants to send information, it first checks Clock to make sure it's at a high logic level.  
If it's not, the host is inhibiting communication and the device must buffer any to-be-sent data 
until it regains control of the bus.  If the Clock line is high, the device can begin to transmit its 
data.  
 
As mentioned in the previous section, device-to-host communication consists of 11-bit frames.  
Each bit is read by the host on the falling edge of the clock, as is illustrated in Figure 4-1. 
 

 
Figure 4-5: Device-to-host communication.  The Data line changes state when Clock is 

high and that data is latched on the falling edge of the clock signal. 

 
As mentioned earlier, the host may inhibit communication from the device at any time before the 
11th clock pulse (stop bit), causing the device to abort transmission of the current byte.  After the 
stop bit is transmitted, the device should wait at least 50 microseconds before sending the next 
packet.  This gives the host time to inhibit transmission while it processes the received byte.  In 
addition, the device should wait at least 50 microseconds after the host releases an inhibit before 
sending any data.  

4.4 Host-to-Device Communication 
The packet is sent a little differently in host-to-device communication.  In order for the host to 
send data to the device, it must first get the device to generate the clock signal.  This is done by 
asserting a “Request-to-Send” state on the Clock and Data lines as follows:  

·  Inhibit communication by pulling Clock low for at least 100 microseconds.  
·  Apply "Request-to-send" by pulling Data low, and then release Clock.  

 
The device should check for this state at intervals not to exceed 10 milliseconds.  When the 
device detects this state, it will begin generating a clock signal and clock in eight data bits and 
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one stop bit.  The host changes the Data line only when the Clock line is low, and data is latched 
on the rising edge of the clock pulse.  This is opposite of what occurs in device-to-host 
communication.  
 
After the stop bit is sent, the device will acknowledge the received byte by bringing the Data line 
low and generating one last clock pulse.  If the host does not release the Data line after the 11th 
clock pulse, the device will continue to generate clock pulses until the Data line is released (the 
device will then generate an error).  
 
The Host may abort transmission any time before the 11th clock pulse (acknowledge bit) by 
holding Clock low for at least 100 microseconds.  
 
To make this process a little easier to understand, here's the steps the host must follow to send 
data to a PS/2 device:  

1) Bring the Clock line low for at least 100 microseconds.  
2) Bring the Data line low.  
3) Release the Clock line.  
4) Wait for the device to bring the Clock line low.  
5) Set/reset the Data line to send the first data bit  
6) Wait for the device to bring Clock high.  
7) Wait for the device to bring Clock low.  
8) Repeat steps 5-7 for the other seven data bits and the parity bit  
9) Release the Data line.  
10) Wait for the device to bring Data low.  
11) Wait for the device to bring Clock low.  
12) Wait for the device to release Data and Clock 

 
Figure 4-2 shows this graphically and Figure 4-3 separates the timing to show which signals the 
host generates, and which the PS/2 device generates.  Notice the change in timing for the Ack bit 
-- the data transition occurs when the Clock line is high (rather than when it is low as is the case 
for the other 11 bits).  
 

 
Figure 4-6: Host-to-Device Communication. 
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Figure 4-7: Detailed host-to-device communication. 

 
Figure 4-3 shows two important timing constraints: (a), and (b).  According to (a), the time it 
takes the device to begin generating clock pulses after the host initially takes the Clock line low, 
must be no greater than 15ms.  According to (b), the time it takes for the packet to be sent, must 
be no greater than 2ms.  If either of these time limits is not met, the host will generate an error.  
Immediately after the packet is received, the host may bring the Clock line low to inhibit 
communication while it processes data.  If the command sent by the host requires a response, that 
response must be received no later than 20ms after the host releases the Clock line.  If this does 
not happen, the host generates an error.  It is also important to note that no Data transition may 
occur within 5 microseconds of a Clock transition.  
 

4.5 Keyboard specifications 

4.5.1 Introduction 

Keyboards consist of a large matrix of keys, all of which are monitored by an on-board 
processor.  The specific processor varies from keyboard-to-keyboard but they all basically do the 
same thing: monitor which key(s) are being pressed/released and send the appropriate data to the 
host.  This processor takes care of all the debouncing and buffers any data in its 16-byte buffer, if 
needed.  

4.5.2 Scan Codes 

Your keyboard's processor spends most of its time scanning, or monitoring, the matrix of keys.  
If it finds that any key is being pressed, released, or held down, the keyboard will send a packet 
of information known as a scan code to your computer.  There are two different types of scan 
codes: make codes and break codes.  A make code is sent when a key is pressed or held down.  A 
break code is sent when a key is released.  Every key is assigned its own unique make code and 
break code so the host can determine exactly what happened to which key simply by looking at a 
single scan code sent from the keyboard.  The set of make and break codes for every key 
comprises a scan code set.  There are three standard scan code sets, named 1, 2, and 3.  Scan 
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code set 2 is the default, and is the only set used by all modern PCs.  Sets 1 and 3 exist for 
compatibility with older systems.  You may switch scan code sets using the "Set Scan Code Set" 
(0xF0) command. 

The three scan code sets are included in section X. 

4.5.3 Make Codes, Break Codes, and Typematic Repeat  

Whenever any key on a keyboard is pressed, that key's make code is sent to the computer.  Keep 
in mind that a make code only represents a key on a keyboard; it does not represent the character 
printed on that key.  This means that there is no defined relationship between a make code and a 
character.  It's up to software to translate the scan codes to characters or commands.  If you want 
to associate a make code with a character, you'll have to implement a look-up table in your 
program.   

Although most set 2 make codes are only one-byte wide, there are a handful of extended keys 
whose make codes are two or four bytes wide.  These make codes can be identified by the fact 
that the first byte is E0h.   

Just as a make code is sent to the computer whenever a key is pressed, a break code is sent to the 
computer whenever a key is released.  In addition to every key having its own unique make code, 
they all have their own unique break code.  Fortunately, however, you won't always have to use 
tables to figure out a key's break code; certain relationships do exist between make codes and 
break codes.  Most set 2 break codes are two bytes long where the first byte is F0h and the 
second byte is the make code for that key.  Break codes for extended keys are usually three bytes 
long and the first two bytes are E0h, F0h, and the last byte is the last byte of that key's make 
code.   

If you press a key, its make code is sent to the computer.  When you press and hold down a key, 
that key becomes typematic, which means the keyboard will keep sending that key's make code 
until the key is released or another key is pressed.  To verify this, open a text editor and hold 
down the "A" key.  When you first press the key, the character "a" immediately appears on your 
screen.  After a short delay, another "a" will appear followed by a whole stream of "a"s until you 
release the "A" key.  There are two important parameters here:  the typematic delay, which is the 
short delay between the first and second "a", and the typematic rate, which is how many 
characters per second will appear on your screen after the typematic delay.  The typematic delay 
can range from 0.25 seconds to 1.00 second and the typematic rate can range from 2.0 cps 
(characters per second) to 30.0 cps.  You may change the typematic rate and delay using the "Set 
Typematic Rate/Delay" (0xF3) command. 
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5.0  Scan code sets 
AT Keyboard Scan Codes (Set 1) 

KEY  MAKE  BREAK  ----- KEY  MAKE  BREAK  ----- KEY  MAKE  BREAK  
A 1E 9E   9 0A 8A   [ 1A 9A 

B 30 B0   ` 29 89   INSERT E0,52 E0,D2 

C 2E AE   - 0C 8C   HOME E0,47 E0,97 

D 20 A0   = 0D 8D   PG UP E0,49 E0,C9 

E 12 92   \ 2B AB   DELETE E0,53 E0,D3 

F 21 A1   BKSP 0E 8E   END E0,4F E0,CF 

G 22 A2   SPACE 39 B9   PG DN E0,51 E0,D1 

H 23 A3   TAB 0F 8F   U ARROW E0,48 E0,C8 

I 17 97   CAPS 3A BA   L ARROW E0,4B E0,CB 

J 24 A4   L SHFT 2A AA   D ARROW E0,50 E0,D0 

K 25 A5   L CTRL 1D 9D   R ARROW E0,4D E0,CD 

L 26 A6   L WIN E0,5B E0,DB   NUM 45 C5 

M 32 B2   L ALT 38 B8   KP / E0,35 E0,B5 

N 31 B1   R SHFT 36 B6   KP * 37 B7 

O 18 98   R CTRL E0,1D E0,9D   KP - 4A CA 

P 19 99   R WIN E0,5C E0,DC   KP + 4E CE 

Q 10 19   R ALT E0,38 E0,B8   KP EN E0,1C E0,9C 

R 13 93   APPS E0,5D E0,DD   KP . 53 D3 

S 1F 9F   ENTER 1C 9C   KP 0 52 D2 

T 14 94   ESC 01 81   KP 1 4F CF 

U 16 96   F1 3B BB   KP 2 50 D0 

V 2F AF   F2 3C BC   KP 3 51 D1 

W 11 91   F3 3D BD   KP 4 4B CB 

X 2D AD   F4 3E BE   KP 5 4C CC 

Y 15 95   F5 3F BF   KP 6 4D CD 

Z 2C AC   F6 40 C0   KP 7 47 C7 

0 0B 8B   F7 41 C1   KP 8 09 89 

1 02 82   F8 42 C2   KP 9 49 C9 

2 03 83   F9 43 C3   ] 1B 9B 

3 04 84   F10 44 C4   ; 27 A7 

4 05 85   F11 57 D7   ' 28 A8 

5 06 86   F12 58 D8   , 33 B3 

6 07 87   PRNT 
SCRN 

E0,2A, 
E0,37  

 E0,B7, 
E0,AA 

  . 34 B4 

7 08 88   SCROLL 46 C6   / 35 B5 

8 09 89   PAUSE E1,1D,45 
E1,9D,C5 

-NONE-         
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AT Keyboard Scan Codes (Set 2) 
KEY  MAKE  BREAK  ----- KEY  MAKE  BREAK  ----- KEY  MAKE  BREAK  

A 1C F0,1C   9 46 F0,46   [ 54 FO,54 

B 32 F0,32   ` 0E F0,0E   INSERT E0,70 E0,F0,70 

C 21 F0,21   - 4E F0,4E   HOME E0,6C E0,F0,6C 

D 23 F0,23   = 55 FO,55   PG UP E0,7D E0,F0,7D 

E 24 F0,24   \ 5D F0,5D   DELETE E0,71 E0,F0,71 

F 2B F0,2B   BKSP 66 F0,66   END E0,69 E0,F0,69 

G 34 F0,34   SPACE 29 F0,29   PG DN E0,7A E0,F0,7A 

H 33 F0,33   TAB 0D F0,0D   U ARROW E0,75 E0,F0,75 

I 43 F0,43   CAPS 58 F0,58   L ARROW E0,6B E0,F0,6B 

J 3B F0,3B   L SHFT 12 FO,12   D ARROW E0,72 E0,F0,72 

K 42 F0,42   L CTRL 14 FO,14   R ARROW E0,74 E0,F0,74 

L 4B F0,4B   L WIN E0,1F E0,F0,1F   NUM 77 F0,77 

M 3A F0,3A   L ALT 11 F0,11   KP / E0,4A E0,F0,4A 

N 31 F0,31   R SHFT 59 F0,59   KP * 7C F0,7C 

O 44 F0,44   R CTRL E0,14 E0,F0,14   KP - 7B F0,7B 

P 4D F0,4D   R WIN E0,27 E0,F0,27   KP + 79 F0,79 

Q 15 F0,15   R ALT E0,11 E0,F0,11   KP EN E0,5A E0,F0,5A 

R 2D F0,2D   APPS E0,2F E0,F0,2F   KP . 71 F0,71 

S 1B F0,1B   ENTER 5A F0,5A   KP 0 70 F0,70 

T 2C F0,2C   ESC 76 F0,76   KP 1 69 F0,69 

U 3C F0,3C   F1 05 F0,05   KP 2 72 F0,72 

V 2A F0,2A   F2 06 F0,06   KP 3 7A F0,7A 

W 1D F0,1D   F3 04 F0,04   KP 4 6B F0,6B 

X 22 F0,22   F4 0C F0,0C   KP 5 73 F0,73 

Y 35 F0,35   F5 03 F0,03   KP 6 74 F0,74 

Z 1A F0,1A   F6 0B F0,0B   KP 7 6C F0,6C 

0 45 F0,45   F7 83 F0,83   KP 8 75 F0,75 

1 16 F0,16   F8 0A F0,0A   KP 9 7D F0,7D 

2 1E F0,1E   F9 01 F0,01   ] 5B F0,5B 

3 26 F0,26   F10 09 F0,09   ; 4C F0,4C 

4 25 F0,25   F11 78 F0,78   ' 52 F0,52 

5 2E F0,2E   F12 07 F0,07   , 41 F0,41 

6 36 F0,36   
PRNT 
SCRN 

E0,12, 
E0,7C  

E0,F0, 
7C,E0, 
F0,12  

  . 49 F0,49 

7 3D F0,3D   SCROLL 7E F0,7E   / 4A F0,4A 

8 3E F0,3E   PAUSE 
E1,14,77, 
E1,F0,14, 

F0,77 
-NONE-         
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AT Keyboard Scan Codes (Set 3) 
KEY  MAKE  BREAK  ----- KEY  MAKE  BREAK  ----- KEY  MAKE  BREAK  

A 1C F0,1C   9 46 F0,46   [ 54 F0,54 

B 32 F0,32   ` 0E F0,0E   INSERT 67 F0,67 

C 21 F0,21   - 4E F0,4E   HOME 6E F0,6E 

D 23 F0,23   = 55 F0,55   PG UP 6F F0,6F 

E 24 F0,24   \ 5C F0,5C   DELETE 64 F0,64 

F 2B F0,2B   BKSP 66 F0,66   END 65 F0,65 

G 34 F0,34   SPACE 29 F0,29   PG DN 6D F0,6D 

H 33 F0,33   TAB 0D F0,0D   U ARROW 63 F0,63 

I 43 F0,48   CAPS 14 F0,14   L ARROW 61 F0,61 

J 3B F0,3B   L SHFT 12 F0,12   D ARROW 60 F0,60 

K 42 F0,42   L CTRL 11 F0,11   R ARROW 6A F0,6A 

L 4B F0,4B   L WIN 8B F0,8B   NUM 76 F0,76 

M 3A F0,3A   L ALT 19 F0,19   KP / 4A F0,4A 

N 31 F0,31   R SHFT 59 F0,59   KP * 7E F0,7E 

O 44 F0,44   R CTRL 58 F0,58   KP - 4E F0,4E 

P 4D F0,4D   R WIN 8C F0,8C   KP + 7C F0,7C 

Q 15 F0,15   R ALT 39 F0,39   KP EN 79 F0,79 

R 2D F0,2D   APPS 8D F0,8D   KP . 71 F0,71 

S 1B F0,1B   ENTER 5A F0,5A   KP 0 70 F0,70 

T 2C F0,2C   ESC 08 F0,08   KP 1 69 F0,69 

U 3C F0,3C   F1 07 F0,07   KP 2 72 F0,72 

V 2A F0,2A   F2 0F F0,0F   KP 3 7A F0,7A 

W 1D F0,1D   F3 17 F0,17   KP 4 6B F0,6B 

X 22 F0,22   F4 1F F0,1F   KP 5 73 F0,73 

Y 35 F0,35   F5 27 F0,27   KP 6 74 F0,74 

Z 1A F0,1A   F6 2F F0,2F   KP 7 6C F0,6C 

0 45 F0,45   F7 37 F0,37   KP 8 75 F0,75 

1 16 F0,16   F8 3F F0,3F   KP 9 7D F0,7D 

2 1E F0,1E   F9 47 F0,47   ] 5B F0,5B 

3 26 F0,26   F10 4F F0,4F   ; 4C F0,4C 

4 25 F0,25   F11 56 F0,56   ' 52 F0,52 

5 2E F0,2E   F12 5E F0,5E   , 41 F0,41 

6 36 F0,36   PRNT 
SCRN 

 57 F0,57   . 49 F0,49 

  3D F0,3D   SCROLL 5F F0,5F   / 4A F0,4A 

8 3E F0,3E   PAUSE 62 F0,62        
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6.0  Host-to-keyboard commands 

The following are the only commands that may be sent to the keyboard:  

·  0xFF (Reset) - Keyboard responds with acknowledge (0xFA) then enters Reset mode.  
·  0xFE (Resend) - Keyboard responds by resending the last scan code or command sent to 

the host.  
·  0xFD (Set Key Type Make) -   
·  0xFC (Set Key Type Make/Break) -  
·  0xFB (Set Key Type Typematic) -   
·  0xFA (Set All Keys Typematic/Make/Break) -  
·  0xF9 (Set All Keys Make) -   
·  0xF8 (Set All Keys Make/Break) -  
·  0xF7 (Set All Keys Typematic) -   
·  0xF6 (Set Default) -   
·  0xF5 (Disable) - Keyboard responds with acknowledge (0xFA), then stops scanning and 

waits further instructions.  
·  0xF4 (Enable) -   
·  0xF3 (Set Typematic Rate/Delay) - Keyboard responds with acknowledge (0xFA), then 

waits for the host to send one more byte, which it also responds to with acknowledge 
(0xFA).  The second byte defines the typematic rate and delay as follows:  

Repeat Rate 

Bits 0-4 Rate(cps)   Bits 0-4 Rate(cps)   Bits 0-4 Rate(cps)   Bits 0-4 Rate(cps) 
00h  2.0    08h  4.0    10h  8.0    18h  16.0  
01h  2.1    09h  4.3    11h  8.6    19h  17.1  
02h  2.3    0Ah 4.6    12h  9.2    1Ah 18.5  
03h  2.5    0Bh 5.0    13h  10.0    1Bh 20.0  
04h  2.7    0Ch 5.5    14h  10.9    1Ch 21.8  
05h  3.0    0Dh 6.0    15h  12.0    1Dh 24.0  
06h  3.3    0Eh 6.7    16h  13.3    1Eh 26.7  
07h  3.7    0Fh 7.5    17h  15.0    1Fh 30.0  

Delay 

Bits 5-6 Delay (seconds) 
00b 0.25 
01b 0.50 
10b 0.75 
11b 1.00 

·  0xF2 (Read ID) - The keyboard responds with "Acknowledge" (0xFA) followed by a 
two-byte device ID of 0x83, 0xAB.  
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·  0xF0 (Set Scan Code Set)  
·  0xEE (Echo) - The keyboard responds with "Echo" (0xEE).  
·  0xED (Set/Reset LEDs) 

The following is an example of a typical initialization sequence between a computer and a 
keyboard upon boot-up: 

Keyboard: AA  Self-test passed   
Host:     ED  Set/Reset Status Indicators   
Keyboard: FA  Acknowledge   
Host:     00  Turn off all LEDs   
Keyboard: FA  Acknowledge   
Host:     F2  Read ID   
Keyboard: FA  Acknowledge   
Keyboard: AB  First byte of ID   
Host:     ED  Set/Reset Status Indicators   
Keyboard: FA  Acknowledge   
Host:     02  Turn on Num Lock LED   
Keyboard: FA  Acknowledge   
Host:     F3  Set Typematic Rate/Delay   
Keyboard: FA  Acknowledge   
Host:     20  500 ms / 30.0 reports/sec   
Keyboard: FA  Acknowledge   
Host:     F4  Enable   
Keyboard: FA  Acknowledge   
Host:     F3  Set Typematic Rate/delay   
Keyboard: FA  Acknowledge   
Host:     00  250 ms / 30.0 reports/sec   
Keyboard: FA  Acknowledge 
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7.0  Booting Linux on the XUP Board 
1. First, open HyperTerminal.  It is found in Start/All 

Programs/Accessories/Communications.   
a. Enter Linux as the name of the connection. 
b. Under connect using: choose COM1 
c. Set the configuration to 9600 baud, 8 data bits, no parity, 1 stop bit, and no flow 

control.   
2. In the lab, there are 8 CompactFlash cards.  They are 1.0GB SanDisk cards.  There 

should be one near your station/board (possibly already resting in the card slot).  Insert 
the CompactFlash card fully into the flash card reader on the XUP board.  The flash card 
has an .ace file on it.  This .ace file contains an image.elf file for the Linux kernel and a 
.bit file with the FPGA configuration information. 

NOTE: It does not matter if the XUP is already power up. As soon as you insert the 
CF card, Linux will start to boot.  

3. Watch the Linux boot process execute in HyperTerminal.  When the login screen 
appears, use root as the username and password.   

4. Explore the Linux filesystem. 
 


